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1 Inleiding 

Dit document dient als gebruikershandleiding voor de rekensheet 

Deltares_passive_sampling_220210.xlm. De rekensheet is bedoelt om de stofwaarden 

verkregen van uitgehangen passive samplers om te rekenen tot vrij opgeloste concentraties 

van de stoffen (organische microverontreinigingen) in het water waar de samplers zijn 

uitgehangen. Deze handleiding beschrijft hoe deze rekensheet gebruikt dient te worden, dat 

wil zeggen van correcte data-invoer tot en met het eindresultaat - de tabel met vrije opgeloste 

stofconcentraties per monster. Er wordt in dit document niet verder ingegaan op de 

wetenschappelijke achtergrond van passive sampling en de onderliggende berekeningen in 

de rekensheet.  Een uitgebreide inhoudelijke Nederlandse  uitleg over het passive sampling 

wordt o.a. gegeven in Smedes, 2010. 

Per tabblad wordt er uitgelegd waar en welke aanpassingen u kunt maken om uw data te 

verwerken. 

 

De excelsheet bestaat uit de volgende acht tabbladen: 

 

• Het tabblad 0_Lees_mij:  Algemene informatie over de rekensheet  

• 1_data_in_format: import locatie waar de data inclusief meta data moet worden 

ingevoerd. 

• 2_PRC:  Hier worden de analysegegevens van de Performance Reference 

Components (PRC’s) opgehaald vanuit het tabblad 1_data_in_format, omgerekend 

naar fractie + correctie voor gewicht van sampler, incl. ruimte voor correctie voor 

afwijkende recovery 

• 3a_Rs calc_Jflex_MW_RAW: In dit tabbblad wordt het bemonsterd watervolume 

berekend aan de hand van het fitten van een Rs model (Rusina et al. 2010) met 

behulp van de excel Solver addin 

• 3_RS_calc_Jflex_MW: Nadat men de tevreden is over de fit van het model en 

nadat er eventuele aanpassingen (weglaten van bepaalde data) zijn gemaakt in het 

bovenstaande tabblad, kan de data naar het huidige tabblad worden gekopieerd 

voor verdere verwerking in tabblad 4. 

• 4_Results_SR: Het resultaten tabblad. In dit tabblad wordt met behulp van de 

eerder verkregen parameters (waaronder sample volume, de bemonsteringsduur en 

het gewicht van de sampler) de vrij opgeloste concentraties in ng/L berekend voor 

de aangetroffen stoffen op de samplers. Ook wordt per stof, afhankelijk van het 

evenwicht, de relevante sample duur weergegeven in de vorm van een Time 

Weighted Average (TWA) periode in dagen. 

• 5_Final_results: Dit tabblad dient als eind resultaat. In het tabblad worden de 

eerdere resultaten van 4_Results_SR gekopieerd als platte waarden. Hierdoor kunt 

u dus makkelijk gegevens aanpassen, kolommen sorteren of formats aanpassen 

zonder dat u bang hoeft te zijn dat onderliggende formules worden gebroken. 

• PRC_Kpw: Lijst met gegevens van de performance reference compounds (PRCs). 

Bevat onder andere de CAS nummers, moleculair gewicht, Kpws en log Kows. Deze 

informatie wordt gebruikt in de berekeningen op de eerder genoemde tabbladen. 

• Alle_Kpw: Lijst met gegevens van alle stoffen (inclusief PRCs). Bevat onder andere 

de CAS nummers, aquokit naam, moleculair gewicht, Kpws en log Kows. Als een 

geanalyseerde stof niet in deze tabel staat, dan moet deze eerst worden toegevoegd 

voordat een concentratieberekening voor de desbetreffende stof kan worden 

uitgevoerd.  

In de onderstaande hoofdstukken wordt per tabblad uitgelegd hoe deze gebruikt dienen 

te worden. 
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1.1 Gebruikte kleurcodes in de rekensheet 

 

In de rekensheet worden voor verschillende cellen, verschillende kleuren gebruikt om dingen 

weer te geven. Afhankelijk van de kleur kan de gebruiker weten wat hij/zij wel of niet met de 

cel kan doen. Hieronder staat het overzicht van de gebruikte kleuren weergegeven. 

 

  Dit zijn headers van tabellen. 

 Dit zijn ook headers van tabellen, maar geven uitleg 

als men op de cel klikt. 

 Bevatten formules, deze cellen mogen niet worden 

aangepast; opmerking: onderliggende berekening zal 

beveiligd worden 

 Hier kan data worden ingevuld en worden aangepast 

door de gebruiker 

 Cellen met dikke rand, betekent dat de gebruiker hier 

waarden kan aanpassen a.d.h.v een keuze menu 

 Parameters voor het fitting model. Mogen niet worden 

aangepast. 
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2 1_data_in_format: Data invoer voor gebruiker 

Zorg ervoor dat u de rekensheet onder een andere naam opslaat voordat u verder gaat met 

het maken van aanpassingen.  

2.1 Het invoeren van data 

Dit tabblad bestaat uit twee tabellen. Een tabel met de meetwaarden en een meta tabel met 

informatie over de sampler. 

 

 
Figuur 1 Overzicht van het tabblad: 1_data_in_format 

 

2.1.1 Tabel 1: invoer analyse data 

De eerste tabel dient de ruwe sampledata te bevatten met CAS-nummers, monsterID 

(sampleID), stofnaam, gemeten waarde (ng/sampler) en of deze waarde het detectielimiet 

betreft. Deze moeten worden geplaatst in een “database” format. Dat wil zeggen per 

monsterID (of sampler) moeten de geanalyseerde stoffen onder elkaar in rijen worden 

weergegeven, zie Figuur 2. In 10 wordt uitgelegd hoe je een tabel waarin de monsterIDs als 

kolommen kunt draaien tot dit format met behulp van de Excel power query. Deze is vanaf 

Excel versie 2016 automatisch ingebouwd, voor de versies 2013 en lager kan het als add-in 

worden gedownload. 

 

De tabel heeft de volgende kolommen die ingevuld kunnen worden: 

 
- MonsterID: Bevat de unieke naam van het monsters/samplers die geanalyseerd zijn. 

Meer meta informatie per monster kan worden ingevuld in de metadata tabel. Veld 

dient als tekst-format te worden ingevuld. Bij wisselende formats (bijv. combinatie 

van tekst en later nummers) kunnen er anders verderop in de excelsheet problemen 

ontstaan met de Look-up functies. 

 

- CAS-nummer: CAS-nummer van de gemeten stof.  

 
- Stofnaam (optioneel): In principe volstaat het CAS-nummer veld om de analyses uit 

te voeren, maar dit veld kan gebruikt worden om een stofnaam in te vullen zoals hij 

bij u bekend is. De rekensheet gebruikt naast de hier ingevulde stofnaam ook de 



 

 

 

8 van 29  Handleiding voor het gebruik van de passive sampling rekensheet 

11210205-000-BGS-0003, 28 maart 2024 

Aquokit stofnaam als deze bekend is (te vinden in het tabblad Alle_KPW) 

 

- Waarde (ng/sampler): De gemeten aangetroffen hoeveelheid van de stof op de 

sampler. 

o  Let op: De eenheid moet ng/sampler zijn om de berekeningen te laten 

kloppen! 

 

- Detectielimiet (<), (optioneel): Vul hier het “<” teken in als de waarde bij de kolom 

E: “Waarde (ng/sampler)” het detectielimiet betreft en niet een meting, zie Figuur 2. 

Let op, hier mag alleen het “<” teken worden ingevuld en geen andere 

tekens/waarden. 

Voorwaarde: 
- De combinatie van MonsterID en CAS-nummer moet uniek zijn.  

- Een CAS-nummer en MonsterID per gemeten waarde is noodzakelijk om verder te 

gaan in de berekening. Stoffen zonder CAS-nummer worden niet verder 

meegenomen. 

- De kolom CAS-short wordt automatisch gegenereerd a.d.h.v. het ingevulde CAS-

nummer en hoeft niet te worden aangepast. CAS-short is niks anders dan het CAS-

nummer zonder – tekens, zodat de rekensheet makkelijker met de data om kan 

gaan. 

- De MonsterID kolom moet het format tekst hebben. 

  

 

 
Figuur 2. Voorbeeld van data in de invoer tabel. In dit geval betreffen de waarden van aldrin en BDE-209 voor 

het monsters “123456-01” het detectielimiet. Dit is aangegeven met  “<” in de kolom Detectielimiet (<). 

Let op: Als u gegevens in deze tabel kopieert vanaf uw eigen database/excelsheet, zorg dan 

dat u de data als waarden (paste as values) plakt. Dit zorgt ervoor dat de celformat van de 

data niet veranderd wat de kans op een niet functionerende rekensheet verkleind.  

Het kopiëren van alleen de waarden (zonder format) kan op twee manieren:  

- via cntrl + alt + v en dan nog een keer v.  

- rechtermuis en dan “paste as values” selecteren: 
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2.1.2 Tabel 2. Meta data. Informatie over de genomen monsters/samplers. 

 

Deze tabel bevindt zich rechts naast tabel 1 (ook in tabblad 1_Data_in_format) en hier kan 

informatie over de monsters die genomen zijn (d.w.z. de uitgehangen samplers) worden 

ingevuld.  

 

Dit betreft de volgende kolommen: 

 
- MonsterID: Naam van het monster of een monstercode. Moet uniek zijn. 

- Monsterdatum: Optioneel. Datum van het uithangen.  

- Extra_info: Optioneel. Extra omschrijving van het monster, bijvoorbeeld een locatie 

of periode 1 t.o.v. periode 2. 

- Accumulatie periode (d): De accumulatie periode in dagen van de uitgehangen 

sampler. 

- Massa blad (g): Het gewicht van de sampler in gram. 

- PRC Referentie. Max 2: Hier kan worden aangegeven of u wilt dat deze sampler 

wordt als referentie voor de Performance Reference Compounds (PRCs) berekening. 

Hier kunnen maximaal 2 referenties voor worden gebruikt. Meer referenties zullen 

door de rekensheet worden genegeerd.  

- Blanco correctie Max 1: Maximaal 1 sampler. Dit is de sampler die verderop in de 

rekensheet (bij tabblad 4_results_SR) gebruikt wordt als blanco correctie bij het 

berekenen van de vrij opgeloste concentraties. Hier kan een veld of lab blanco voor 

worden gebruikt. Let op deze sampler mag ook dienen als PRC referentie, zie Figuur 

3.  

Als allebei de tabellen zijn ingevuld kunt u door gaan naar het volgende tabblad: 2_PRC. 

 

 
Figuur 3. Ingevulde meta data tabel. Let op een PRC referentie mag ook dienen als Blanco correctie. 

2.2 Extra informatie over het tabblad 

Naast deze twee tabellen, zit er ook een zogenaamde helper tabel in de kolommen U:Y. 

Deze tabel sorteert de aangegeven referenties en blanco. De kolommen zijn verborgen voor 

de gebruiker en dienen niet te worden aangepast, maar kunnen zichtbaar worden gemaakt 

via unhide columns (cntrl + shift + 0). 
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3 2_PRC: Berekening van het PRC evenwicht 

In dit tabblad worden de analysegegevens van de PRC’s worden opgehaald vanuit het 
voorgaande tabblad 1_data_in_format en omgerekend naar fractie. Dit is inclusief correctie 
voor gewicht van de individuele samplers. Er is hier ruimte voor correctie van afwijkende 
recovery. 
 
Het tabblad bestaat uit 4 tabellen.  
1. Ophalen van benodigde meta data van de samplers 
2. Analyse gegevens vanuit het tabblad 1_data_in_format van de PRCs 
3. Berekening van relatieve concentraties, inclusief correctie voor gewicht sampler 
4. Correctie op bovenstaande relatieve concentraties, afhankelijk van afwijkende recovery  
 

 
Figuur 4. Overzicht van het tabblad “2_PRC” 

Er zijn relatief weinig aanpassingen die u in dit tabblad hoeft uit te voeren. De rekensheet 
haalt namelijk automatisch de benodigde informatie uit het tabblad 1_data_in_format.  
Wel kan een controle worden uitgevoerd om te zien of de in tabblad 1_data_in_format 
aangegeven PRC referenties ook daadwerkelijk als referentie worden gebruikt en of de 
opgehaalde waarde zoals accumulatieperiode en sampler gewicht kloppen. 
 

3.1 Stap 1 Ophalen PRCs 

De PRC waarden die worden opgehaald uit tabel 1 van 1_data_in_format zijn afhankelijk van 
door u aangegeven PRCs in de lichtblauwe velden A12:A25, zie Figuur 5. 
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Figuur 5. De velden A11:A25 van tabblad “2_PRC”. Hierin kunnen in de lichtblauwe velden CAS-nummers 

worden aangepast om andere PRCs als referentie te gebruiken. 

De in Figuur 5 weergegeven PRCs zijn als standaard ingevuld in de rekensheet. Mocht u een 
andere PRC willen gebruiken, dan kunt u een ander CAS-short nummer invullen. Dit is het 
CAS-nummer van de stof, maar dan zonder de “-“. Deze nummers kunt u vinden in het 
tabblad PRC_Kpw.  
Staat het nummer nog niet in het tabblad PRC_Kpw, dan moet u deze eerst in die tabblad 
toevoegen voordat u het CAS-short nummer in het tabblad 2_PRC kunt invullen, zie 
hoofdstuk 7 en 8 voor extra informatie. 
 

3.2 Stap 2 Correctie 

Indien het noodzakelijk is, kunt u in de onderste tabel van het tabblad het aantal PRCs 
aangeven waarover een recovery correctie uitgevoerd kan worden. Bijvoorbeeld wanneer de 
relatieve concentraties van stoffen met hoge hydrofobiciteit uiteindelijk onder of zelfs boven 
de 1 zitten, wat niet zou moeten omdat deze stoffen helemaal niet naar de waterfase gaan 
tijdens de blootstelling. Een mogelijke oorzaak wordt gegeven in Smedes (2010):  
 
“In principe zou de Nt gelijk moeten zijn aan N0 voor stoffen die op basis van hun hoge 
hydrofobiciteit helemaal niet naar de waterfase gaan tijdens de blootstelling. In de praktijk 
verschillen Nt en N0 dan nog wel eens. Meestal is de afwijking klein en voor een enkele stof 
niet significant (valt binnen de analysespreiding), maar als het voor meerdere stoffen 
optreedt, kan een correctie wenselijk zijn. Oorzaken van de verschillen kunnen liggen in een  
klein verschil in sorptiecapaciteit van de sampler of in matrixinvloeden op het signaal.  
Correctie kan worden uitgevoerd door de fe-waarden te delen door de fe (of het gemiddelde  
van meerdere) van sterk hydrofobe stoffen. De Kpw-waarden van die sterk hydrofobe stoffen  
moeten dan wel ongeveer 1,5 logeenheid hoger zijn dan de Kpw-waardewaarbij de curve het  
fc=0.5 doorsnijdt. De sterk hydrofobe stoffen worden zo, net als interne standaarden in een  
analytisch proces, als ankerpunt gebruikt.”  
 
U kunt het aantal PRCs van onderaan de tabel naar boven geteld aangeven via het 
lichtblauwe veld H45, zie Figuur 6. Bij de waarde 0 wordt er geen correctie uitgevoerd en zijn 
de waarde gelijk aan die van tabel 3. 
 



 

 

 

12 van 29  Handleiding voor het gebruik van de passive sampling rekensheet 

11210205-000-BGS-0003, 28 maart 2024 

 
Figuur 6: Overzicht van de laatste tabel in het tabblad 2_PRC. 

 
Indien de data akkoord zijn, kunt u door gaan naar de tabblad 3, 3A_Rs 
calc_Jflex_MW_RAW  waar een model op de PRC waarden wordt gefit.   
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4 3A_Rs calc_Jflex_MW_RAW. Fitten van model 
en berekening van bemonsterd volume 

 
In dit tabblad wordt het fitting model (Rusina et al. 2010) toegepast op de eerder berekende 
relatieve PRC waarden. Dit wordt gebruikt om vervolgens een benadering voor de 
parameters FA (flow factor * oppervlakte[m2]), de bemonsteringsnelheid (Rs in L d-1) en 
Sampled volumes (L) te berekenen. 
 
Het tabblad bestaat uit 2 tabellen en 2 figuren en 2 knoppen, zie Figuur 7. 

- De onderste tabel (met lichtblauwe velden) moet informatie bevatten uit de eerdere 
berekeningen van de tabbladen 1 _data_in_format en 2_PRCs.  

- De oranje tabel bevat de waarden van het model en berekening van parameters die 
nodig zijn voor de vervolg berekeningen in tabblad 4 Results_SR. 

 
De twee figuren bovenaan het tabblad laten, nadat het model gerunt heeft, zien hoe goed de 
fitting van het model is t.o.v. van de gemeten waarden. Een voorbeeld van een nette fitting is 
weergegeven in Figuur 8. 
 
Met behulp van de twee knoppen genaamd “Copy data” en “Run Solver” kan informatie in het 
tabblad worden ingeladen en kan de fitting van het model gerunt worden.  
 

 
Figuur 7. Overzicht van tabblad “3a_RS calc Jflex_MW_RAW” 
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Figuur 8. Voorbeeld van een nette fitting met relatief kleine verschillen tussen de gemeten en gemodelleerde f 

waarden. Figuur overgenomen uit Smedes, 2010 pagina 16. 

 

4.1 Stappenplan: importeren van benodigde informatie 

- De berekende data van de PRCs en benodigde meta data van de samplers kan 

worden opgehaald uit het vorige tabblad 2_PRC door op de knop “Copy data from 

2_PRC_sheet” te drukken. 

  

 
- De lichtblauwe velden van F35:Y61 zullen worden bevolkt met de bovengenoemde 

informatie. De informatie hiervan kan naar gelang worden aangepast. Let op, geen 

rijen of kolommen verwijderen! Anders kunnen de onderliggende berekeningen 

namelijk worden verstoord. 

 

- Het kan zijn dat de solvent blank wordt meegerekend als monster. Dit gebeurd 

wanneer u in tabblad “1_data_in_format” de solvent blank heeft geselecteerd als 

blanco correctie, maar niet als PRC referentie.  Om te voorkomen dat de blanco 

verder wordt meegerekend als monster en daarmee dus meegenomen wordt in het 

fitting model kunt u deze in dit tabblad verwijderen. 

o Dit kan door de monster informatie van de blanco correctie te deleten in de 

lichtblauwe velden van F35:Y61. Let op: Voer deze stap uit voordat u de 

solver knop runt. 
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- Vervolgens kunt u op de “Run Solver” knop drukken om de Excel Solver add-in te 

laten runnen. Deze zal de waarden van FA gaan schatten om tot een zo goed 

mogelijke fit te komen. 

 
 

o De solver knop zorgt bij het opstarten van de rekensheet dat de benodigde 

solver add-in voor u wordt geïnstalleerd als deze nog niet was geïnstalleerd. 

Hierdoor kunt u meteen de solver runnen. Indien de solver add-in niet vooraf 

was geïnstalleerd , dan wordt deze ook weer gede-installeerd bij het sluiten 

van het bestand. 

o Mocht het nu zijn dat de knop niet werkt dan kunt u handmatig de addin 

installeren en runnen via de volgende stappen (afkomstig uit : Load the 

Solver Add-in in Excel (microsoft.com) 

▪ File > Options 

▪ Click Add-Ins, and then in the Manage box, select Excel Add-ins. 

▪ Click Go. 

▪ In the Add-Ins available box, select the Solver Add-in check box, and 

then click OK. 

▪ Notes: If the Solver Add-in is not listed in the Add-Ins available box, 

click Browse to locate the add-in. 

▪ If you get prompted that the Solver Add-in is not currently installed 

on your computer, click Yes to install it. 

▪ After you load the Solver Add-in, the Solver command is available in 

the Analysis group on the Data tab. 

- U kunt de fitting van het model voor de verschillende monsters bekijken via de cel 

J21 

 
o De figuren zullen automatisch mee veranderen naar het geselecteerde 

monster. 

 

- INSPECT de fitting in de figuren.  

o In het linker figuur is de modelfit (zwarte lijn) weergegeven. De rode punten 

zijn de gemeten waardes. 

 

https://support.microsoft.com/en-us/office/load-the-solver-add-in-in-excel-612926fc-d53b-46b4-872c-e24772f078ca
https://support.microsoft.com/en-us/office/load-the-solver-add-in-in-excel-612926fc-d53b-46b4-872c-e24772f078ca
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o Het rechter figuur laat de residuele afwijkingen t.o.v. de modelfit zien. 

Wanneer de afwijkingen van de residuals rondom de fitting erg hoog is (sum 

of squares > 0.12) wordt dit weergegeven onder dit figuur: 

. 

 

 
-  Als er een reden is om data niet mee te nemen (bijv uitschieters die SSQ erg 

beïnvloeden) plaats dan een #  voor de betreffende waarde in de lichtblauwe velden 

van F40:Y61. Vergeet niet daarna de Solver opnieuw te runnen. 

Als u tevreden bent over de fitting kunt u doorgaan naar het volgende tabblad: 

3_RS_calc_Jflex_MW.  

 

4.2 Extra informatie over het tabblad 

- De kolom A en de rijen 62 t/m 169 bevatten de onderliggende berekeningen en zijn 

verborgen om het tabblad overzichtelijker te maken en om de berekeningen tegen 

niet bedoelde bijstellingen te beveiligen. De rijen kunnen zichtbaar gemaakt 

doormiddel van het hele tabblad te selecteren via de "select all" knop, gevolgd door 

ctrl + shift + 9 voor de rijen. 

  
 

Solvent blank is nu opgenomen en berekend zoals een monster. Dat maakt fcalc #VERW in figuur 1. 
Dus solvent blank moet er uitgehaald worden, tenzij het de bedoeling is om solvent blank mee te 
nemen in de berekening.  
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5 3_Rs_calc_Jflex_MW: aanleveren data voor 
vervolg berekeningen 

Dit tabblad lijkt zeer veel op het voorgaande tabblad en is dan ook bedoelt als tussenstap 

voor de vervolg berekeningen in het tabblad 4_Results_SR.   

Wanneer u tevreden bent met de eerder gemaakte fitting in het voorgaande tabblad, zie 

3A_Rs calc_Jflex_MW_RAW. Fitten van model en berekening van bemonsterd volume, dan 

kunt u deze informatie hierin kopiëren. 

Het kopiëren van de data naar dit tabblad is noodzakelijk omdat de vervolg berekeningen 

refereren naar de informatie in dit tabblad. Deze tussenstap is toegevoegd om de rekensheet 

sneller te maken en om te zorgen dat de gebruiker aanpassingen in de gegevens kan maken 

zonder dat hij/zij zich zorgen hoeft te maken om onderliggende formules te breken.  

Dit tabblad bevat 1 knop: Copy raw data sheet 3A, zie Figuur 9. 

 

 
Figuur 9. Overzicht van het tabblad “3_Rs_calc_Jflex_MW” 

 

5.1 Stappenplan  

- Importeer de data uit het voorgaande tabblad met de knop “Copy raw data sheet 

3A” 

 
- Als alles goed gaat, zullen de velden van C22:Y61 worden bevolkt met de data uit 

het voorgaande tabblad. 

o De knop kopieert alleen waarden, dus de onderliggende formules worden 

niet mee gekopieerd. 
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- Als de data goed is gekopieerd ,kunt u door gaan naar het volgende tabblad: 

4_Results_SR 
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6 4_Results_SR Berekening vrij opgeloste 
concentraties (ng/L) 

 

In dit tabblad wordt de vrij opgeloste concentraties (ng/L) berekent van de in tabblad 1 

“1_data_in_format”  ingevulde stoffen. Dit wordt gedaan aan de hand van de eerder 

berekende/geschatte parameters uit de tabbladen 2, 3A en 3. 

Het tabblad werkt van rechts naar links. De hulp tabellen/berekeningen staan rechts en gaan 

in stappen naar links zodat de eindresultaten aan het begin komen.  

 

Het tabblad bestaat uit 5 tabellen. Van links naar rechts zijn dit: 

 
1. Gebruikte gegevens uit tabblad “Alle KPW”. (Start in cel A13) 

a. Dit is een tabel informatie over de stoffen die in het tabblad worden 

geanalyseerd. De tabel bevat de volgende kolommen de logKpw, MW 

(molecuul gewicht), K_origin (manier waarop Kpw bepaalt is) en de aquokit 

stofnaam. 

i.  
2. Berekende vrij opgeloste concentraties in ng/L (Start in cel F13) 

a. Tabel met eindresultaten, waarin de berekende vrij opgeloste concentraties 

van alle geanalyseerde stoffen  (met uitzondering van de PRCs aangegeven 

in tabblad 2_PRC, A12:A25) worden weergegeven per monster. 

b. Daarnaast worden boven de tabel ook de meta informatie voor zover 

ingevuld per monster weergegeven. 
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3. TWA (Time Weighted Average) periode in dagen (Start in cel AI13) 

a. Deze tabel geeft per stof en per monster aan of er een evenwicht is bereikt 

eerder dan de totale accumulatie periode.

 
4. Gemeten waarden opgehaald uit tabblad 1_data_in_format (Start in cel BK13) 

a. Dit is de tabel die per stof en per monster de gemeten waarden ophaalt uit 

door u ingevulde tabel 1 van tabblad 1_data_in_format. Vanuit deze tabel 

worden de andere tabellen berekent

 
5. Waarden uit tabblad 1_data_in_format die het detectielimiet betreffen. (Start in 

cel CN13) 

a. Dit is een hulp tabel die per stof en per monster kijkt of de opgehaalde 

waarden van de bovenstaande tabel het detectielimiet betreft of niet.

 

 

6.1 Stappenplan voor berekening 

 

- Druk op de knop “Importeer stoffen uit data_in_format tabblad”. 

 
o De knop zorgt ervoor dat de unieke CAS-short-nummers van kolom 

F3:F10000 in het tabblad 1_data_in_format, worden opgehaald en geplaatst 

in de cel F13 t/m Fxxx (het aantal unieke CAS-nummers dat de dataset 

bevat) van de tabblad 4_Results_SR. 
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▪ Een handige controle is om te kijken of dit aantal overeenkomt met 

het verwachte aantal stofnamen, mogelijk is een CAS nummer niet 

goed omgezet naar CAS-short nummer. 

▪ Let op, de gebruikte PRC stoffen van tabblad 2_PRC (veld A12:A25) 

worden niet meegenomen. 

 
- Nadat de CAS-short nummers zijn gekopieerd zal de rekensheet automatisch de 

berekeningen uitvoeren.  

 
- U heeft hierbij de mogelijkheid om bepaalde dingen aan te passen 

o Veld F10: Het aantal significante decimalen van het eindresultaat 

 
o Veld F11: Of er een correctie voor sampler gerelateerde achtergrondwaarde 

moet worden toegepast. Default is ja. 

 
o Of u het CAS-nummer of CAS-short nummer wilt weergeven in de tabellen 

en of u de Aquokit stofnamen wilt gebruiken of 1 van de andere 

mogelijkheden, zoals uw eigen ingevulde stofnamen 

 
o Veld CI13: Welke van de aangegeven referentie samplers/blanco u wilt 

gebruiken voor de blanco correctie. Default is de aangegeven blanco 

correctie 

 
 

- Let op! Om de berekeningen uit te voeren heeft de rekensheet de waarden uit de 

tabel “Gebruikte gegevens uit sheet Alle KPW” (Veld A13:D2000) nodig per cas-

nummer. Deze waarden worden opgehaald uit het tabblad Alle_KPW.  

o De berekening kan niet worden uitgevoerd voor een stof als: het 

betreffende CAS nummer niet in de lijst van Alle_KPW staat, of wanneer 1 

van de benodigde gegevens niet is ingevuld in de lijst. 

o Dit wordt rij cellen zal dan roze worden gekleurd om aan te geven dat er iets 

niet in orde is. 

 
o Deze waarden dienen eerst onderin de lijst van Alle_KPW te worden 

ingevuld voordat de berekening kan worden gedaan. Meer informatie 

hierover in de uitleg van de tabblad Alle KPW, hoofdstuk 7. 

 
- Wanneer een berekende vrij opgeloste concentratie (ng/L) het detectielimiet betreft 

wordt de waarde weergegeven met een kleiner dan “<” teken ervoor. Ook zal de cel 

geel oplichten zodat de gebruiker makkelijker ziet dat het een detectielimiet betreft. 

 
Tot slot 

- Als u tevreden bent over de resultaten dan kunt u deze als platte waarden kopiëren 

naar het tabblad “5_Final_results” met behulp van de knop “Kopieer berekende 

waarden + format”. Deze bevindt zich boven de tabel Berekende vrij opgeloste 

concentraties in ng/L (Start in cel F13). 

- Alleen de waarden in de tabellen Berekende vrij opgeloste concentratie en TWA 

in dagen worden dan gekopieerd. U kunt dus in het tabblad “5_Final_ results” 
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aanpassingen maken in de data of kolommen sorteren op, bijvoorbeeld, stofnaam 

zonder dat u bang hoeft te zijn om onderliggende formules te breken.  

 

 

6.2 Extra informatie 

 

Het tabblad “4_Results_SR” is gebaseerd op een oudere versie van de rekensheet, die niet 

het detectielimiet per sampler per monster berekende. Hierdoor staan er ook nog de 

kolommen Cw uit analytische Detectielimiet en Detectielimiet via productie blanco 

(respectievelijk AC13:AC2000 en AD13:2000) 

 
Als u gewend bent deze te gebruiken dan kunt u de detectielimieten per stof invullen in de 

kolom CJ13:CJ2000 genaamd “detectielimiet”. Vervolgens zullen de 2 velden worden 

berekend. 
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7 Alle_KPW lijst: lijst met stofeigenschappen 

Het tabblad waarin de benodigde gegevens in staan van alle voor in de rekensheet bekende 

stoffen. Dit betreft het CAS-nummer, CAS_short nummer, stofnamen zoals Aquokit, log Kow, 

Kpw, logKpw, qualifer (manier waarop Log Kpw is verkregen), cv Kpw, MW (molecular weight) 

en referenties. 

 
Figuur 10. Overzicht van tabblad “Alle KPW” 

 

7.1 Stappenplan 

Om stoffen toe te kunnen voegen, dient u onderaan de lijst, de nieuwe gegevens in te vullen. 

Hierbij zijn in ieder geval de volgende velden verplicht (anders kan de berekening niet 

worden uitgevoerd): 
- CAS-nummer 

- CAS-nummer short (is CAS nummer zonder “-”). Deze gebruikt de rekensheet om 

data met elkaar te koppelen. 

- LogKpw (passive sampler-water partition coefficients) 

- MW (Molecular weight) 

- Qualifier 

o Dit  is de manier waarop de logKpw is bepaald. Bijvoorbeeld via de cosolvent 

model methode voor J-flex of Altesil of als schatting adhv van Kow (octanol-

water partition coëfficiënt) 

De overige velden zijn niet direct noodzakelijk maar het is bijvoorbeeld voor een zo’n volledig 

mogelijk beeld. Bijvoorbeeld door de aquokit stofnaam weer te geven en een referentie waar 

bijvoorbeeld de Kpw’s dan wel Kow’s zijn verkregen.  
- Let op! Voeg de stoffen altijd onderaan de lijst in, achter de laatste rij met gegevens. 

Laat hierbij geen rijen leeg 

- PRCs die gebruikt worden als referentie dienen ook toegevoegd te worden aan het 

tabblad PRC_KPW.  

7.2 Verkrijgen van benodigde informatie per stof 

- Als de Kpw  van een stof niet bepaald is via bijvoorbeeld de cosolvent model 

methode, dan kan de Kpw geschat worden via de Kow. Deze Kow gegevens evenals de 

MW zijn bijvoorbeeld beschikbaar via bronnen zoals Chemspider/Episuite of de 

CompTox Chemicals Dashboard (CompTox Chemicals Dashboard (epa.gov) 

 

 

 

 

https://comptox.epa.gov/dashboard/
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8 PRC_Kpw: lijst met stof eigenschappen voor 
PRCs 

Dit is het tabblad waarin de benodigde gegevens van de performance reference compounds 

(PRCs) staan die gebruikt worden voor tabblad 2_PRC. De waarden in dit tabblad kunnen op 

dezelfde manier worden ingevuld als voor het tabblad Alle KPW. 
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10 Appendix A 

De onderstaande uitleg is afkomstig van de Microsoft website via de link: 

Unpivot columns (Power Query) (microsoft.com) 

 

Omdat links nogal eens willen breken is worden de stappen hieronder ook weer gegeven. In 

het onderstaande voorbeeld is ook gebruik gemaakt van How To Unpivot Data With Power 

Query | How To Excel om een duidelijker beeld te geven. Mocht de huidige informatie door 

veroudering niet meer van toepassing zijn dan wordt aangeraden om te googlen op “unpivot 

using power query excel”. Onderstaande tekst is in het engels. 

 

Unpivot columns (Power Query) 
Excel voor Microsoft 365 Excel 2021 Excel 2019 Excel 2016 Excel 2013 Excel 2010. 

 

You might want to unpivot data, sometimes called flattening the data, to put it in a matrix 

format so that all similar values are in one column. This is necessary, for example, to create a 

chart or a report. 

 

 
 

When you unpivot, you unpack the attribute-value pairs that represent an intersection point of 

the new columns and re-orient them into flattened columns: 

 

• Values (in blue on the left) are unpivoted into a new column (in blue on the right). 

• Attributes (in green on the left) are unpivoted into a new column (in green on the 

right) and duplicates are correspondingly mapped to the new Values column. 

 

  

https://support.microsoft.com/en-US/office/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098
https://www.howtoexcel.org/how-to-unpivot-data-with-power-query/
https://www.howtoexcel.org/how-to-unpivot-data-with-power-query/
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Unpivot columns 
Here is the sample data used in this procedure. 

 
 

1. Make sure that the data is a table.  

a. Select your data. 

b. Select Home > Format as Table. 

2. Select a cell within your data. 

3. Go to the Data tab in the ribbon and press the From Table/Range button. The query 

editor will open. 

 
 

4. Left click on the first column heading. 

 Hold the Shift key. 

 Left click on the last column heading. 

5. Right click on any of the selected columns and select Unpivot Only Selected 

Columns from the menu. 

           

 
 

6. The query editor preview will show the unpivoted data. You can rename the columns 

from the default Attribute and Value to something more relevant with a double left 

click on the heading. In our case these should be MonsterID Sold and Waarde. 
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7. Go to the Home tab in the query editor and press the Close & Load button to save 

the query and output the resulting data to a new sheet. This is a very quick way to 

reformat your data back to a more usable tabular format. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

29 van 29  Handleiding voor het gebruik van de passive sampling rekensheet 

11210205-000-BGS-0003, 28 maart 2024 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


